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Hygiena International is a world leader in the development and supply of 
rapid diagnostic and monitoring systems to detect and measure microbial 
contamination in finished products bound for consumers. It has successfully 
developed tests for use in the dairy, beverage, personal care & cosmetic 
and pharmaceutical markets and is associated with some of the best-known 
brands in the industry. Hygiena’s other division is a leading global provider of 
quality in vitro ADME-TOX cellular research products. For more information, 
visit hygiena.com.  
 
Welcome to the Hygiena Innovate system, designed to be the dairy and 
beverage industry standard for manufacturers using microbial screening 
to release their products to market. The Hygiena Innovate system was 
developed by Hygiena International based on input from dairy and beverage 
customers worldwide and is designed to offer simplicity of operation that is 
unmatched in the marketplace.  

The Hygiena Innovate luminometer, the corresponding Innovate.im 
software and reagents and the Hygiena employees that stand behind them, 
comprise the Hygiena Innovate system. Together, all four components work 
together to provide the functionality and simplicity users need to meet their 
evolving demands.   

About Hygiena

Welcome to 
the Hygiena 
Innovate System



4

Hygiena Innovate  System

This Operator Manual describes the specific use of the Hygiena Innovate 
luminometer to perform Hygiena assays. The Hygiena Innovate Operator 
Manual is organized as follows:  

Section 1	 Provides a general introduction to the Hygiena Innovate 
luminometer and Innovate.im software.  

Section 2 	 Describes the installation of the Hygiena Innovate instrument.  

Section 3 	 Describes the installation of the Hygiena Innovate.im software.  

Section 4 	 Describes how to use the Hygiena Innovate system.  

Section 5 	 Describes how to use the system administration features  
of Innovate.im. 

Section 6 	 Provides a general introduction of the Innovate.im  
database software.   

Introduction
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Hygiena has done everything possible to guarantee that the equipment 
functions safely, both electrically and mechanically. The user must ensure 
the instrument is installed and maintained properly to guarantee safe 
operation. The Hygiena Innovate has been manufactured in accordance 
with international safety requirements for electronic and medical measuring 
systems.

The Hygiena Innovate is tested by the manufacturer and supplied in a 
condition that allows safe and reliable operation. Failure to follow the 
instructions may invalidate the warranty.  

•	 The Hygiena Innovate luminometer must be installed and used 
in  accordance with Hygiena recommendations. Installation must be 
performed by properly trained and authorised personnel.  

•	 The Hygiena Innovate should only be operated by personnel who have  
been trained on the use of the system. It is strongly recommended that  
all users read this manual prior to use.  

•	 Hygiena assumes no liability for any damages, including those to third  
parties, caused by improper use or handling of the instruments.  

•	 It is the user’s responsibility to have the instrument installed according 
tothe local electrical codes (110 - 240V).  

•	 The instrument is in accordance to CE Marked, UL, CSA, EN 61010-1,  
EN 61326-1, EN 61000-3-2 and EN 61000-3-3 for electrical equipment.  

•	 The Hygiena Innovate is equipped with a 3-wire grounded plug  for 
safety. If your outlet does not accommodate the 3-wire plug, an  
electrician should install the correct outlet or use an adaptor to ground 
the instrument.  

•	 The instrument cover should never be opened while the instrument  
is running. Service and repair work may only be carried out with the  
guidance of or by qualified Hygiena personnel.  

•	 If liquid gets inside the instrument, unplug the power cord. Clean the unit 
or have it cleaned by an authorized service representative.  

•	 The system must only be used with Hygiena reagents and microtiter 
plates, in accordance with the instructions provided on the reagent kit 
insert.  

•	 Waste from the instrument’s waste system (when priming/washing 
the instrument) must be disposed of properly. A plastic container 
is connected to the instrument to collect the waste. All statutory 
requirements for handling biological waste and reagents must be 
observed by the user.   

Hygiena 
Innovate

1.1 Safety and 
Operating 
Instructions
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•	 The Hygiena Innovate instrument should be shipped in its own case.  
During transport the plate carrier must be secured by the transportation 
lock screw. The system needs to be washed and primed with washing 
solution leaving liquid in the injector lines. External tubing and injector 
needles should remain attached to the instrument and placed in a plastic 
bag.  

•	 The tests and maintenance work recommended by the manufacturer 
should be performed routinely to ensure the system operates as 
intended.  

To obtain the best results, consider the following:

•	 Do not expose the instrument to direct sunlight.  

•	 Install the instrument in a dry location where humidity levels do not  
exceed 85%.  

•	 Keep plate carrier door closed at all times except when loading/unloading  
microtiter plates.  

•	 Keep plate carrier free from dirt. Do not lean on plate carrier or move  
by hand.  

•	 Clean up reagent spills on instrument immediately.  

•	 Do not use the luminometer in an environment where the temperature  
exceeds 30ºC.

The Hygiena Innovate system has been designed to deliver easy-to-use and 
robust capability to users. Due to its sophisticated technology and ease-of- 
use, it is well suited for dairy and beverage applications.

The instrument works with an extremely low-noise photomultiplier. The 
highest sensitivity possible is obtained due to the use of single photon 
counting technology and patented crosstalk reduction design. Specific 
Hygiena Innovate system features:  

•	 Use of three (3) variable volume bellows-based injectors allowing precise, 
reliable and automatic injection of reagent.  

•	 Comprehensive shaking functionality to maximize mixing of sample and  
reagents.  

•	 Temperature control allows reagents to be used up to 5 days when stored  
in the Hygiena Innovate reagent cooling unit.  

•	 Comprehensive Innovate.im software for instrument control and data  
management. Unique multi-tasking capability enables users to run one  
assay while preparing another.  

•	 Connection to automated laboratory systems such as LIMS.  

•	 Multiple user functionality allows multiple workstations to access results 
in the database via a network. Remote workstations can also access 
networked database results.

1.2 System 
Description 
and Technical 
Specifications
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The Hygiena Innovate is a desktop microtiter plate luminometer and 
may be installed in any laboratory workplace meeting the manufacturers 
recommended specifications as listed in section 1.1 above.  

Technical Specification  

Dimensions 	 33 x 43 x 27 cm  
Operating Environment Conditions 	 Ambient temperature <30°C  
Relative Humidity 	 <85%  
Voltage 	 110-240V  
Weight 	 25.2 kg (Instrument, Reagent  
	 Tray, Cooling Unit)  

Plate Carrier  
The instrument contains a plate carrier accessible through the front panel  
door. Controlled via Innovate.im software, the plate carrier moves the  
microtiter plate to the defined measurement and injection positions.   

Connections at Rear Panel 
The PC connection, power supply, waste outlet, power switch and 
instrument fuse are located on the instrument rear panel.  

•	 USB  port 
The USB port is used to connect a computer to the Hygiena Innovate.  

•	 Power plug 
Connects the instrument to power using the cable supplied with the 
instrument.

•	 Power switch 
Used to turn the instrument on and off.  

Note: Turn the instrument on before starting the  software, so the program 
can establish communication with the instrument.   

Section 1

Figure 1: Plate carrier on instrument front panel  
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Waste outlet 
Connects the waste container to the instrument.  

Fuse 
The instrument fuse is located next to the power switch  
in a black fuse holder.   

Injectors  
The Hygiena Innovate has three variable injectors. Please see kit insert for 
setting up injectors with reagents. The injectors are located on the right 
side of the instrument. The tubing from the reagent vials is connected to the 
injector ports using screw-type caps.

Figure 3: Injector ports on right side of instrument

Reagents  

Injector 1 (Red)  

Injector 2 (Green)  

Injector 3 (Yellow)   

Fuse USB 
Port       

Power 
Plug

Power 
Switch

Instrument
Label

Waste 
outlet

Injector ports 1, 2, 3

Figure 2: Ports on instrument rear panel 
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Reagent Tray  
The reagent tray is placed on the right side of the instrument. A special  
temperature control unit is placed inside the reagent tray in order to maintain  
optimal reagent temperature and prolong stability. Please see reagent kit 
insert for further details on reagent usage. Two washing solution vials are 
placed in the reagent tray to wash the injectors daily during Start-up and 
Shut-down.   

Figure 4: Reagent tray

Innovate.im Requirements  
Innovate.im requires the following minimum computer hardware  
specification:  
- Processor 	 1GHz  
- RAM 	 1Gb  
- Hard Driver 	 100Mb free hard drive space  
- Graphics Card 	 1024 x 768  
- Optical Drive 	 CD-ROM  
- Operating System 	 Windows 7 Professional,  
	 Windows XP Professional,  
	 Windows Vista Business  
- Communication Ports 	 USB, Parallel (if needed for printer)  
- Web Browser 	 Internet Explorer 6.0 or higher (optional)  
- Peripherals 	 Mouse, Keyboard, Monitor  

Multiuser functionality requires the following minimum specifications in  
addition to above system requirements. All users must have full read and 
write permissions for the Networked folder where the database tables 
are stored. For optimal speed no more than 4 systems should access the 
networked database tables.  
- Network Speed 	 1Gbps  
- RAM 	 2Gb  
- License 	 Needed for remote users not attached to a  
	 Hygiena Innovate luminometer  

IMPORTANT: Plate preparation files, report templates, pre-defined queries,  
and database export drivers must be configured identically on all networked  
systems.   

Section 1

1.3 Innovate.im 
Software
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Innovate.im Structure  

The Innovate.im software is used for the control of the Hygiena Innovate  
luminometer. The software allows different permission levels. There are four  
default settings:  

User 	 This user level allows access to plate prep and 
	 performing measurements while restricting access 
	 to protocol settings and installation settings.  

Administrator 	 Full access rights.  

Superviser 	 This user level allows full access rights except  
	 installation settings.  

Superuser 	 This user level allows access to plate prep and  
	 performing measurements with the ability to 
	 modify results by right clicking on the well in the 
	 result matrix view. Superuser has restricted access 
	 to protocol settings and installation settings.

The illustration below shows the menus and associated functions within  
Innovate.im. Some functions may not be visible when not logged in as 
System Manager.   

Brief Explanation of Menus and  Functions

File menu	 In this menu you Open, Save, Export or Print files 
Plate Preparation enables the user to enter the 
sample identification information of each plate 
before measurement.

Edit menu 	 This menu allows you to copy and paste data.

View menu 	 In this menu you select special views. For example 
you can show or hide the Task Pane or the Help 
Pane.

Section 1

File Edit View Instrument Installation Help 

Data Undo Category Bar Load Plate Settings Help Pane

Protocal Copy Task Pane Unload Plate Automation About 
Innovat.im

Print Paste Help Pane Prime Driver

Print Preview Reset Protocol Wash

Export Results Boot 
Instrument

Plate 
Preparation

Matrices Reagent 
Levels

Database Statistics MM&C

Logout Shipping 
Brace

Exit
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Instrument menu	 The instrument functions are presented in this menu:

Load Plate	 Used to move the plate carrier into the luminometer 	
	 below the photomultiplier.  

Unload Plate	 Used to move the plate carrier out of the 
	 luminometer so you may unload the current 
	 microtiter plate and load a new one.  

Prime	 Used to prime the injector tubing for operation 
	 Select the injector(s) and start the prime function.  

Wash	 Used to wash the injector system.  

Boot Instrument	 Used to establish communication between 
	 instrument and PC for those instances when  the 
	 Hygiena Innovate instrument has been  turned off 
	 and on again while working in Innovate.im.  

Reagent Levels	 Used to enter the volume of the reagents 		
	 connected to the instrument.  

Shipping Brace	 Used to move the plate carrier to the transport 
	 position in order to secure the safety screw for 
	 transportation.

Installation menu	 The Installation Settings dialog box is used  
(Administrator only)	 to define the settings (directories, password, etc.). 
	 In the Installation Driver dialog you select and 
	 setup drivers for the Innovate instrument, export 
	 functionality and Plate preparation.  

Help Menu	 This menu provides information about the software 
	 version as well as a link to the help pane.  

Directly underneath the menubar is located a symbolbar. This bar consists of  
icons used to provide shortcuts for many of the program tasks you are likely  
to use often. On the bottom of the main window the status bar is positioned.   

This line provides real-time information during the assay. On the right hand 
side  of the screen, a Help Card with step-by-step operating instructions is 
shown when activated in the View menu.   

Section 1



12

Hygiena Innovate  System

This section will lead you step-by-step through the Hygiena Innovate  
luminometer installation process.

The Hygiena Innovate should be set up in a dry, dust-free room and 
protected from direct sunlight and significant temperature fluctuations. 
It should not be set up next to heating or air conditioning units. The 
luminometer should be operated in an environment where the temperature 
does not exceed 30 ºC and  humidity levels are below 85%.  
The luminometer has the following dimensions:  

•	 W x D x H: 33 x 43 x 27 cm  

•	 The instrument should be set up so the rear panel connection ports are 
easily accessible and not subjected to physical stress.  

•	 Allow for sufficient space on the side of the instrument for the reagent 
tray and the PC used for Innovate.im.

The original packaging is reusable and should be retained for any future  
transport of the instrument. When unpacking the instrument, make 
sure the shipment is complete and shows no sign of transport damage. 
The packaging is designed to eliminate transport damage. Should the 
instrument or instrument parts appear damaged, please notify your local 
Hygiena representative immediately.  
Please verify that all components were shipped and received in good 
condition by referencing the packing list provided with the instrument. If 
items are missing or damaged, please contact Hygiena immediately.   

Remove the transport safety screw  

•	 Red label is placed in front of the  
instrument to remind you to remove  
the transport safety screw (a).  

•	 Unscrew the instrument cover with the 
screw driver supplied (b), unlock the lid 
by loosening the screw and open the lid.   

Section 2

A

B

Innovate 
Installation

2.1 Space 
Requirements

2.2 Unpacking

2.3 Connecting
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•	 Remove all foam pieces 
inside the instrument (c), 
(d).

•	 Unscrew transport safety screw.  
This screw secures the plate carrier  
and should always be engaged to  
prevent damage when shipping the 
instrument.  

•	 Place red label inside the instrument 
(f) to the right side of the transport 
screw.   

•	 Close instrument cover and replace  
lid screw and white cap (g), (h).   

Electrical connections  

•	 Connect the USB cable provided to the port located on the rear of 
the Hygiena Innovate. Do not connect the USB cable to the PC until  
installation of Innovate.im software. (See Section 3.1).   

Section 2

Foam
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Note: Check if power supply is within the permissible range of the Hygiena  
Innovate operating voltage. Connect instrument only if the power supply is  
110 - 240 V.  

•	 Connect instrument to the wall outlet using the power cord supplied.  

•	 If you have not already done so, connect the computer to the wall outlet.  

•	 Connect temperature control unit to the wall outlet using the power  
cord supplied.   

Figure 5: Hygiena Innovate rear panel  

Reagent tray  

Assemble the Reagent tray using the Allen key supplied with the Innovate.  
The tray contains two tube holders, one with an opening and one without 
an opening. Place the tube holder with the opening at the front side of the 
tray. The liquid level will be visible through the opening. Place the cooling 
unit inside the tray.   

Figure 6: Assembling reagent tray   

Section 2

Fuse   Power plug   
Power 
switch  

Reagent 2 Reagent 1 

Reagent 3

Washing 
solution

Temperature 
control unit
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Waste and reagent tubing

•	 Connect supplied waste tubing to the waste outlet.

Figure 7: Connecting tubing to waste outlet  

•	 Add a few drops of antifoam to the waste container.  

•	 Place waste tubing into the waste container to collect the waste solution.  

•	 Instrument is shipped with external reagent tubing connected to  
injectors 1, 2, and 3. 

Figure 8: Connecting reagent tubes

•	 Place all three injector needles in washing solution. 

Note: Wear gloves when touching the injector needles.   

Section 2
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This section will lead you step-by-step through the installation of  
Innovate.im software on your computer.  

Note: Before beginning the installation process, close all applications  
on your computer.  

The Innovate.im program needs to be installed before driver software.  
Install the Innovate.im program from the supplied CD-ROM. This is the 
PC software for the control of the Hygiena Innovate. Prior to installing 
the Innovate.im software, ensure that the USB cable is connected to the 
Hygiena Innovate, but is not connected to the PC.  

1.	 Insert the Innovate.im CD-ROM into your drive. If asked for permission 
to access the computer, allow access. The installation routine starts  
automatically.  

2.	 Click <Next> in the Innovate setup window.  

3.	 Select the language to install and click OK.  

4.	 Follow the on-screen prompts to finish the installation of Innovate.im.  

Note: Before startup of the software, the driver must first be installed. See  
section 3.2 for instructions to install the driver.  

1.	 Insert the CD containing the Hygiena Innovate driver software into the  
CD-ROM drive. If asked for permission to access the computer,  allow 
access. The installation routine starts automatically.  

2.	 Choose the language to install and click Next.  

3.	 Follow the on-screen prompts to complete the driver installation. When  
the Options Window appears, check the box next to Startup/Shutdown  
procedure to require the Hygiena Innovate to perform a wash cycle and 
a prime when starting and shutting down the software. If the box is not  
checked, the user will need to manually perform these functions  
as needed.  

4.	 Upon successful driver installation, remove the CD from the  
CD-ROM drive.  

5. 	 Power on the Hygiena Innovate instrument and plug the USB cable into  
the USB port on the PC.  

6. 	 Startup the Innovate.im program by double clicking on the desktop icon.  
If the following screen appears, click on the driver to highlight and click  
Driver Setup.   

Section 3

3.2 Driver

3    Installation of  
Innovate.im 
and Driver 
Software

3.1 Single System

Innovate.im 
Installation

Software 
Installation

Innovate.im  
A Hygiena 
shortcut icon will 
automatically 
appear on your 
desktop.
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The following screen appears:   

Select the ComPort drop down menu and select the other com port number  
listed in the drop down box. Click OK and click OK to continue.   

Section 3
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A multiple user network can be set up so that multiple workstations have  
access to a single networked database table. This allows sample results to 
be stored in a single location and accessed from multiple systems as well 
as remote computers without an instrument attached.  

Note: Remote computers accessing the networked database tables 
without an instrument attached will need to acquire an activation code to 
use Innovate.im.

1.  Install Innovate.im on all computers as a single instrument installation.  

2.  Remote computers without an instrument attached will need to  
acquire an activation code to use Innovate.im. Once the software is  
installed:  

a.  Login to Innovate.im. The installation driver window appears.  

b.  Click OK. The program activation window appears.  

c.  Click on Send Email and remove the current recipients. Send the 
email to wgannon@hygiena.com. Once activation code is received, 
it should be entered into the Activation Code section of the 
Program Activation  window.  

3.  With assistance from IT personnel, create an Innovate.im database table  
folder on the local network. Grant all Innovate.im Database users full  
permissions to this folder.  

4.  Set-up Innovate.im Database Table on a Network  
Using one workstation designated as the master workstation, transfer 
the Innovate.im database tables to the database table folder on the 
local network as follows:  

a.  Login to Innovate.im using an ID with system administration rights.  

b.  Click on the Database icon to open the database.  

c.  From the Options menu, select Network Settings.  

d.  In the Options Network Settings Dialog box select the Move tab.  

e.  Click Move.  

f.   In the Browse for Folder dialog box navigate to the database  

table folder on the local network. Click Open.  

g.  The database table is moved to the local drive.  

h.  Link the database for the master workstation to the database  
	 tables by selecting Networks Settings from the Options menu  
	 in the database software.   

Section 3

3.3 Networked 
multiple user 
option
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i.  Click the Link Tables tab and Click Link.  

j.  Navigate to the database folder on the network and select the  

“databasetable.dbf” file to link.  

5.  Set-up a workstation to access the network database table  

Using a different workstation from step 4 above, link the database 
tables on each computer to the table on the local network as follows:  

a.  Login to Innovate.im using an ID with system administration rights.  

b.  Click on the Database icon to open the database.  

c.  From the options menu, select Network Settings.  

d.  In the Options Network Settings dialog box select the 
	 Link Tables tab.  
e.  In the dialog box, navigate to the database table folder on the 
	 local network.  
f.  Open the folder by double-clicking on it.  

g.  Select “databasetable.dbf” and click Link.  

h.  The workstation is now linked to the local network database table.  

Note: If data already exists on the workstation, you will be prompted to  
transfer that data to the networked table.  

IMPORTANT: All workstations accessing the networked database must 
have the same settings for the Hygiena Database Export Driver and the 
Hygiena Plate Preparation Driver in order to maintain the integrity of 
the data as it is written to the networked table. If columns have been 
customized, the same customizations will need to be made to all other 
workstations writing data to the networked database.   

Section 3
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First switch on the instrument and then start up the Innovate.im program 
on your PC by double clicking on the Innovate.im icon on your desktop or  
selecting Innovate.im from your start menu. The following screen will  
appear:

If the installation driver window appears, change the com port by 
highlighting the driver and selecting driver setup. In the window that 
appears, change the comport and click ok.  

Select User using the arrow box next to User name and enter the 
password User. Press OK to confirm.  

After clicking OK, the instrument functions are initialised and the interface  
connection between the PC and instrument is verified.  

The main window of Innovate.im is displayed.   

Section 4

4   Start up of 
Innovate 
System
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The task pane and/or help pane can be selected in the view menu to include  
all views (Task Pane and Help Pane).   

Note: Innovate.im features a built-in help Pane system that provides users  
with step by step guidance for system operation. The Help Pane can be left 
on screen when needed or available through the View menu.  

Measurement protocols are already defined for users in the parameter  
files. The basic parameter definitions supplied by Hygiena, include typical  
measurement sequences of the major measurement types. The predefined  
parameters determine how each sample is to be tested, including injector  
volumes and timings (incubation – measurement). The type of measurement 
is indicated in the file name.  

Different sample types (e.g. InsBlank, ATP or Dairy products) can be 
measured simultaneously using the same parameter file. Sample specific 
parameters, like injector volumes and threshold values are pre-defined in a 
product specific Assay definition.  

The pre-defined threshold values can be reviewed via the Innovate.im  
Help Pane.   

Section 4

4.1 Protocol 
verification
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Take the dispensers out of the carton boxes and assemble as follows. 
Please use gloves to avoid contamination during assembly.   

•	 Push discharge tube into socket on 
side of dispenser and screw into 
place. Ensure that the opening of the 
tube points straight down.   

•	 Push the intake tube (straight) onto the 
bottom of the dispenser.   

•	 Screw the dispensers onto the  
appropriate dilutor/buffer bottles  
(for more information see   
applicable kit insert).  

•	 Prime both dispensers before first use.   

When handling the reagent injector needles, wear gloves to avoid possible  
contamination.  
Prepare the reagents for use on the Hygiena Innovate system as described 
in the kit insert supplied with each individual reagent kit.  
Please refer to the kit insert or contact your local Hygiena representative if 
you encounter any problems.  
The Hygiena Innovate is controlled and operated via the Innovate.im  
software. Innovate.im is used to wash and prime the injector system as  
recommended.   
Injector tubing needs to be washed using Hygiena washing solution in  the 
following circumstances:  

•	 Before beginning work  

•	 After finishing work and before turning off the instrument  

•	 When in continuous operation, a minimum of once every 24 hours  

•	 When not in continuous operation, a minimum of once every 12 hours  

•	 If instrument stands idle, once every month to replace washing solution 
inside the tubing   

Section 4

4.2 Preparation 
of bottle top 
dispensers 
(only for kits 
containing 
bulk 
reconstitution 
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Steps for washing  

Note: All three injectors are selected in the Wash step only during installation  
of the instrument. Routinely only injector 1 + 3 need to be washed during 
start-up. Cellsolver reagent remains connected to injector 2.  

•	 Connect washing solution to all injector needles.  

Note: Before priming or washing the system, please be sure that the waste  
container is properly connected and empty.  

•	 To wash the injectors with washing solution, select Instrument / Wash.   

•	 Select all three injectors and click Next.  

The following screens will appear:   

•	 Click Next to start washing. The following screens will appear:   

Section 4
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Priming the Instrument   

Injector tubing must be primed with its respective reagents before  
starting the first measurements of the day.

•	 Place the reagent vials into the Reagent Holder and connect the  
reagent vials to the injector needles. Place the injector needles into the  
corresponding appropriate reagent (see kit insert for details).  

•	 Click Instrument / Reagent Levels to enter the volumes of the 
connected reagents (see kit insert for more detailed information).  

	 You can do this either by typing directly in the boxes, or by using the  
arrow buttons beside each box. Click Add/Subtract for each injector to 
accept the volume. Select Last Settings in case reagents are left over  
from the previous day.

•	 Confirm your entries with Close.  

•	 Select Instrument / Prime to prime the reagents.  

•	 Select all three injectors in the following screen:   

Section 4
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•	 Select Next to move to the following screen.   

•	 Select Next to start the priming of the reagents. 
The following screen will appear:

Note: Take care that the injector needles are inserted down to the bottom 
of the reagent vials to avoid air entering into tubing. Air in the tubing can  
negatively impact the operation and performance of the system.   

Section 4
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Pipette each sample into its microtiter plate well. Injection of reagent and 
the measurement will take place by column from the upper left well to the 
lower right well.

Note: Make sure that the product is carefully pipetted into the bottom of 
the well. Avoid distributing sample on the side of the well. This will help to  
ensure the sample is fully mixed with the reagent during the assay.  

Plate preparation 

In order to define your plate for measurement, select PlatePrep icon in the  
toolbar. The following screen will appear.   

•	 Before an assay and product can be selected, you must first type the  
Plate name into the Plate ID box and press Enter on the keyboard.  

Note: Each plate prep must have a unique name. A uniform naming 
convention should be established and used each time a new plate is  
prepared. Hygiena recommends using the date, initials and plate number 
during a shift, for example 07152010 jr plate 1, 07152010 jr plate 2, etc.  

•	 To load a previously run plate to use as a template, select load plate 
after  assigning a unique name. Select the desired plate prep file.  

•	 Click the arrow next to the Protocol box, and select the protocol you  
wish to use from the drop-down menu that appears.   
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Select the Assay in the Assay drop down menu.

Use the screen at the bottom of the page to select the wells on the plate, 
there are four options:  
Select individual well by well.  

Select entire columns by clicking on the columnheader (01, 02, ...)   
Select multiple cells on the top left cell and simply drag your cursor over the  
desired cells.   

Section 4
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Sample Identification  

Use the Upper Screen to insert the Sample Information. Sample information  
can be inserted in the columns in the upper portion of the screen by clicking  
in the corresponding cell. For ease of operation the cell colours selected in 
the bottom screen will correspond to the cells on the left side in the upper 
screen.  

By default, Sample ID is also displayed for each well in the lower portion 
of the window. This option can be changed in the plate prep driver. See 
section 6 for instructions how to customize the plate prep window.  

Note: All Sample information must be entered before commencing the  
measurement.  

In case you would like to copy data in multiple cells during the sample ID  
process, select one of the Data Input buttons:  

Repeat	 Identical data will be copied in all cells of the 
selected column.   

Select the entire plate by clicking on the top left grey cell in the corner.   

In this example below the daily control samples will be tested (Instrument 
Blank in cells A01 and B01, Reagent Blank in cells C01 and D01, ATP Positive 
Control in cells E01 and F01) followed by a number of Dairy Samples.   
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Increment 	 Data will be copied and automatically increased in  
case a number is entered (see Sample no. column  
example on the next page).  

Copy data to multiple cells  

Select the cells you would like to copy. Click with the right mouse button on 
the highlighted cells and select Copy. Select the cell in which the data should 
be pasted downwards, click again on the right mouse button and click Paste.

Copy data to multiple cells using repeat or increment mode

In order to copy data in a column select the column to be copied by 
clicking on the cell containing the column header. Hold the Ctrl button and 
double click on one of the highlighted cells that need to be filled. Type the  
appropriate information into the cell and press Enter. All information will be  
copied or incremented based on the data input mode selected 
(Repeat/Increment).   

Column widths are adjustable. Simply position the mouse pointer over a line  
beside the column heading you wish to adjust. Hold down the mouse button  
and drag it left or right to narrow or widen the column.

Note: Column headers can only be edited by the System Manager.   

Once you have completed your plate layout and sample identification and  
would like to measure directly this predefined plate click on Run Plate.   

Section 4
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The file name will be saved and automatically selected for measurement.  
Measurement can be started by selecting Start.  
After completion of the plate layout and sample identification, Save Plate 
can be selected to save all information and a new plate can be prepared by  
selecting New Plate to define your next plate. To print the plate layout, click  
print plate. 

Select Exit to leave the Plate Preparation Screen. You can start the  
measurement afterwards.  

Enter the plate name into the Plate ID field or select start to load a 
previously prepared plate. Click the green start button to run the plate.   

The plate carrier ejects from the luminometer automatically. The following  
window appears on the screen:   

Load the plate (with A1 at rear left) and click OK. There is only one way to  
put the plate in the instrument.  

The plate is moved into the instrument and the pre-defined measurement  
sequence will be carried out. However, the Innovate.im will first calculate 
how much of each reagent is needed to test all selected wells. If insufficient 
reagent levels have been detected, the system will prompt the user to 
add more reagents. The system will not start measuring without adding 
reagents. The following window will appear:   

Section 4
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•	 Click on OK and the following Reagent Level Adjustment box will  
appear:   

•	 Add the appropriate volume of the reagents by using the arrows beside  
each amount box or type the volume direct into each box. Click Add/
Subtract for each injector to accept the volume.  

Note: If you need to reduce the amount of reagent registered, include a 
minus sign (-) before the amount in the box before clicking Add/Subtract.  

•	 When you have added all required reagent volumes, click on Close and 
the measurement of samples will start.  

During measurement RLU values and results are shown on the PC. Data is 
shown in two views: Result Matrix. This screen shows the microtiter plate 
layout with Sample ID, RLU and Result. The result interpretation is colour 
marked as defined in the assay definition. This matrix is usually opened 
during measurement.   
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Result List 	 This screen shows all entered sample information, 
measured RLU value and results in list format. This 
screen is usually opened after the measurement to 
review all data and results.   

Note: If RLU thresholds for results interpretation need to be adjusted, 
please contact your local Hygiena representative for further details.  

Upon completion of the measurement the plate stays within the instrument. 
It can be unloaded by the Instrument / Unload Plate command.  

After the measurement select Print to print the results.

In order to clean the injectors, place the injector needle (1) and injector  
needle (3) from the reagents into the vials containing washing solution. 
When handling the injectors, wear gloves to avoid possible contamination.  

Note: Lightly shake the injector needles to remove reagent before inserting  
into the washing solution.  

The Reagent 2 remains connected to the instrument.   
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Select Instrument / Wash and select Injector 1 and Injector 3.   

Click on Next to proceed to the next screen.   

Click on Next to start the cleaning of the injectors.   

This completes the cleaning of the instrument.  
Close software and power down the instrument.   

Section 4
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The injector system should be cleaned on a monthly basis, following the 
last assay of the day.  

1.	 Before beginning the MM&C procedure, empty the waste container.  

2.	 For the 3 injector lines pour the contents of Reagent 1 and connect to  
the 3 injectors.  

3.	 Select Instrument/MM&C. The following screen appears.   

Note: The instrument and software must remain active throughout the  
cleaning procedure. Do not turn off the instrument or close out Innovate.im.  

4.	 Follow the onscreen prompts to begin injection of Reagent 1. Leave  
Reagent 1 in place until the cycle completes. The onscreen progress bar  
will indicate the status of completion.   

Section 4
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5.	 Once complete, pour the contents of Reagent 2 into PP vial(s) 
and connect to all injector lines to be treated.   

6.	 Follow the onscreen prompts to begin injection of Reagent 2. Leave  
Reagent 2 in place until the cycle completes. The onscreen progress  
bar will indicate the status of completion.   

7.	 Once complete, pour the contents of Reagent 3 into PP vial(s)  
and connect to all injector lines to be treated.   

Section 4
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8. 	 Follow the onscreen prompts to begin injection of Reagent 3. Leave  
Reagent 3 in place until the cycle completes. The onscreen progress bar  
will indicate the status of completion.   

9. 	 The Maintenance & Cleaning procedure is now complete. Connect the  
Microwash to the Injectors and wash and prime with reagents as normal  
before proceeding with assays.  

Note: Do not re-use reagents and 25ml PP-vials. Discard all open  
vials after use.   

Section 4
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Innovate.im has several system administration features that can be used 
to manage the system. These features can be accessed by selecting 
installation from the top menu bar and then selecting Settings.

General Tab	 Changes display of wells, delimiters, anddisables 
ID’s for control positions. This feature should only 
be changed after consulting Hygiena technical 
support.  

Directories Tab	 Changes the Measurement, Template, and 
Transfer directories.

Password Tab

Add/Edit user	 Login information. See section 5.1 for further  
instruction.  

Font Tab 	 Change the font in the Calculations or Statistics 
windows.  

LogSystem Tab	 Track events in the system log. See section 5.2 
for further instruction.  

New users can be added or existing user information can be edited by  
selecting Installation from the top menu bar then selecting Settings and 
clicking on the Password Tab. The following screen appears.   
A user can be deleted by highlighting the user name and selecting the 
Remove User button.   
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To add a new user click the Add User button.  

To edit an existing user, select the user ID and click Edit User. The following 
screen appears.   
Type the new user name and password. The user name and password 
must be a minimum of 4 characters. Confirm the password and select the 
expiration date.

Access rights can be customized for each user. Hygiena recommends 
daily users of the system be given User access rights. An Administrator, 
Supervisor, or Super user level access rights login should be assigned to 
the onsite system administrator. See section 1.3 for detailed descriptions of 
each user account level.  

The system log tracks all events in Innovate.im. To access this feature select  
Installation from the top menu bar and select Settings. Click on the Log  
System tab. The following screen appears.   
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To activate the system log, check the box next to Activate LogSystem. This  
will create a record of events in Innovate.im. 

Select the Log Level  

Level 1	 Collects basic information suitable for audit purposes.  
Recommended default level.  

Level 2 	 Collects additional system information. Use only as directed by  
technical support.  

Level 3	 Collects the maximum amount of system and user information.  
Use only as directed by technical support.  

Note: Log Levels 2 and 3 collect additional system information and create  
larger system log files which can impact system performance if used for  
extended periods of time. For best performance, use Log Level 1 setting.  
To search for events by date, use Show all before feature.  
To find events by a specific user ID, type the user ID in the Show User field  
and select Set.  

To search for specific events, type the event description in the Show  
Operation box and select Set. This field is case sensitive.  
The search results can be limited by designating the number of records to  
display in the Number of – maximum field and selecting Set.  
Print the results displayed by selecting the Print List button.   
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The plate prep window can be customized to show additional user specified  
columns and control how data is entered into each field so that all data is  
uniformly transferred to the database. This aids the query process when  
filtering data in the database.
  
Creating Custom Columns  
To create custom columns in the plate prep window, select Installation/
Driver and click the Sampler tab. Click the driver displayed in the driver 
window and select Driver Setup.   

The window that appears allows the user to add or remove columns from 
the plate prep window, provide custom names for the columns and change 
the order of the columns.   

Section 6

6 Customizing 
the plate prep 
window



41

Hygiena Innovate  System

To add a new custom column, click the location in the displayed list where  
the desired column is needed.   

Click Add and select the type of column desired.  

Text 	 Text or number can be typed into this field. A maximum of 6 
text columns may be displayed in the plate prep window.  

Number	 Only numbers can be typed into this field. A maximum of 2  
number fields may be displayed in the plate prep window.  

Date	 Only dates can be entered into this field. A maximum  
of 3 data fields may be displayed in the plate prep window.   

To change the name of a column, click on the desired column in the list and  
select edit.   

To delete a column from the list, select the column name and click Delete.  

Note: The Sample ID column can never be deleted.   
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Columns are displayed in the plate prep window in the same order as 
they are displayed in the Column Adjustment list. To change the order of 
columns, add or delete columns to obtain the desired order in the list.  
The user can also specify which column information to be displayed in the  
lower portion of the plate prep window. Select the desired column in the list  
and click Indicator. The indicator in the list changes from No to Yes.   

To select which column information prints when the plate layout is printed,  
select the desired column and click Print. The Print in the list changes from 
No to Yes.   

Creating Lookup Tables  
The column Mode can be fixed or variable.  

Fixed 	 Forces a user with User level permissions to use only 
the data specified in a lookup table defined by a system 
administrator.  

Variable	 Allows the use of a lookup table or the ability to enter data 
into the field.  

To change the mode, select the desired column and click Mode.   
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To setup a lookup table for a field, select the desired column in the list.  
Click Edit in the Lookup section to the right.   

The lookup table box appears.   

In the lookup table box, click Add Item. Select the new item  
and click Edit Item.   

Enter the desired data and press enter. Add, edit, or delete items  
as needed and then click OK.  

Note: Any changes to the plate prep driver will not take effect until the  
software is restarted.   
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Innovate.im contains a very powerful database feature. This feature can be 
used to query the data and create reports.  

All results from Innovate.im are automatically saved in th`e database as soon 
as the measurement of the microtiter plate is finished.  

To open the database you can either select the Database icon on the Toolbar 
of the Innovate.im software or Select File Database.   

The database screen will appear:   

The illustration below shows the menus and functions of the 
Innovate.im database. Some functions may not be visible if not 
logged in with system administration rights.
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Brief Explanation of Functions

File Menu  

Export / Export setup	 This option allows you to export data from  
the Innovate.im database to Microsoft Excel.  

Print / Print preview/	 Option to print data from the database.
Print setup 	 Printer setup option can be used to define the  

layout of your printed report.  

Backup database / 	 A backup of the database can be performed
Compact and restore	 in order to avoid losing data. The compact 

function can be used to keep a large database 
operating at optimal performance. Restore is  
used to restore a backup.  

Archive transfer 	 Data can be archived to the existing archive 
table in order to improve database performance.  

Create new archive 	 Create/manage archive tables.  

Close 	 To exit the database and return back to the  
Innovate.im software.  

Edit  

Copy / Paste 	 Copy and Paste function can be used to enter  
additional sample information into the database.  

Options  

Setup filters 	 Filters can be defined in order to search for 
specific data (e.g. Sample ID, RLU).  

Show columns 	 Option to define which columns should be 
displayed on your screen.  

Network Settings 	 Database can be linked to tables on a server for  
multiple user access. 

A symbolbar is located directly underneath the menubar. The icons found 
here provide shortcuts for many of the program tasks you are likely to use.   

Section 7
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The database screen shows you all columns from the Plate Preparation 
screen, measurement results and some editable columns.

You can define which columns you would like to have in your database view  
by clicking on Options / Show columns. The following screen will appear:   

Use the check boxes to select the columns you would like to have in your  
database:   

You can arrange your choice of columns in a particular order by a simple 
drag of the mouse. Position the mouse pointer on the most left box adjacent 
to the column name you wish to re-arrange. The pointer will change to an 
arrow shape.  

Click and hold down the left mouse button and drag the columns to the new  
position.  

Select Close to leave this option.   
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Column widths are adjustable. Simply position the mouse pointer over a line  
beside the columns heading you wish to adjust.   

The pointer will change to an arrow shape. Hold the mouse button and drag  
it left or right to narrow or widen the column.   

If you would like to add additional sample information, select the column in  
which you would like to enter additional information either by clicking on the  
specific column header:   

or by selecting the Edit data icon on the symbolbar.   

All editable columns will be marked with a pencil: 

Click into one cell of an editable column and type the appropriate  
information. Double-click on it to highlight it, and select Edit / Copy on  
the Menubar.

Highlight the cell you wish to fill and select Edit / Paste on the Menubar. The  
contents of the original cell will be copied to the highlighted one.

Identical information can be added to each field in an editable column.

IMPORTANT: Before performing this function, be sure to apply a data 
filter so that only the desired data to be edited is showing. The following 
procedure will edit the fields of all data in a specific column that is showing 
on the screen.

If you would like to add identical information into one editable column, click  
on the Enter data icon on the symbolbar.  

The following screen will appear:   
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Click on the arrow beside the box marked “Select Column” and select the  
column in which you would like to add the information.  

Type the appropriate information in the box “Enter value for selected  
column” and confirm by clicking on OK.  

Click Yes to confirm that you would like to add the entered information in  
the pre-selected column. (Prod. Type in this example).  
The following screen will appear:   

Click Yes to confirm that you would like to overwrite the data.  

The following screen will appear:   

In case Repeat will be selected, Identical data will be copied in all cells of 
the selected column. In case Increment will be selected, data will be copied 
and automatically increased in case a number is entered.  

Note: This action will add data to all selected cells in the column.   
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There are different options to search for particular data. These options can 
be used, for example, to look for particular Plate or Sample ID’s, Products or  
RLU results.  

Quick filter - Search by selecting a cell  
Position the mouse pointer in one cell, which contains the information you  
are searching e.g. all Chocolate milk samples, a specific production date or 
Sample ID.  

Click on the right mouse button and the database will only show you the  
results with the identical information in the same column.  

Selection of data through predefined filters  
The Innovate.im database contains predefined filters, which can be used to  
review data.  

Click on Select data in the symbolbar.   

The following screen will appear:   
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As an example, we will search for samples with positive RLU values. This  
means we search for RLU values above the predefined threshold limit of 80  
RLU. Select RLU and confirm your selection by clicking on Apply.

The following screen will appear:   

The predefined RLU filter of > 80 RLU can be accepted by clicking OK.  

Note: In case you would like to change the criteria of 80 RLU, for example  
for specific products with higher threshold values, you can enter a different  
RLU value in the box. Confirm by clicking OK.  

Note: In case multiple criteria are defined within one filter, the Skip button  
will give the possibility to skip one of the criteria for this selection.  

The database screen will only show you the Samples with RLU results 
above 80 RLU.   
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Selection of data by creating custom filters  
If you wish to search for particular data, the system manager can create  
company specific filters. The filter can be defined based on one Criterion or 
a combination of different criteria.

To access the filter setup window, select Options/Setup filter from the top  
menu bar.   

The icons displayed in the filter setup window perform the following  
commands:  

New 	 Creates a new filter  

Open 	 Opens the filter list dialog box to open an existing filter  

Apply 	 Applies the current filter  

Save 	 Opens the filter list dialog box to save a new or revised 
filter with a user specified name  

Delete 	 Opens the filter dialog box to delete a saved filter  

To open a pre-existing filter select Open from the filter setup window. The  
filter list dialog box appears.   

In this dialog box the user may open a filter by selecting the filter name and  
clicking Select. You may also reorder the list by selecting the filter name and  
clicking and dragging the   to the left of the name.  

To rename a filter, first open the filter then click Save and select a new name.   
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Creating a new filter  
To create a new filter, select Options/Setup filter from the top menu bar. The  
following screen appears:   

A filter condition contains a Relation to combine multiple criteria, a Column 
to search, an Operator to define the condition and a Criteria expression with  
which you want to search. If you want a filter to prompt you for the criterion 
each time the filter is used allowing you to change the criteria parameters 
each time, select the Prompt box.

Link	 For a single criterion in the first row, leave link blank.  
Multiple criteria need the relational link And/Or in order to  
define whether to search for items that include both criteria 
1 and 2 or search for items that include either criterion 1 or 
2. If no link is defined when multiple criteria are entered, the  
system will use And to relate the criteria by default.  

Column	 Click the column drop down arrow to select which column 
to apply the condition to when searching. To remove a 
condition from the filter, select the empty space at the top of 
the list of columns names.  

Operator	 Select an operator by clicking on the drop down arrow.  
Begins with: Specifies that the column value must begin 
with the specified string in the criteria field e.g. C will return  
records for Chocolate and Cherry.

	
	 Is equal to: Specifies that the column value and the value 

in the criteria field have the same value e.g. Vanilla will only  
return records for Vanilla.   
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Is greater than: Specifies that the column value must be more than the 
value in the criteria field e.g. 7 returns records 8, 9, 10, etc.

Is greater than or equal to: Specifies that the column value must be the 
same or more than the value in the criteria field e.g. 7 returns 7, 8, 9, 10, etc.  

Is less than: Specifies that the column value must be less than the value in 
the criteria field e.g. 7 returns 2, 3, 4, 5, 6.  

Is less than or equal to: Specifies that the column value  must be the same 
or less than the value in the criteria field e.g. 7 returns 2, 3, 4, 5, 6, 7.  

Does not equal: Specifies that the column value must not be the same ast 
he value in the criteria field e.g. 7 returns all value except 7.  

Is empty: Specifies that the column value must contain an empty field.  

Is not empty: Specifies that the column value must contain  
no empty fields.  

Contains: Specifies that the column value must contain the specified string 
in the criteria field e.g. S returns records for Soy, Lines, HTST etc.  

Not all operators are compatible with all columns. If the operator is not  
compatible with the column selected, the error message Operator Mismatch 
will appear when running the filter.   
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Permitted Operators

Criteria 	 Specifies the value or text with which you want to search.  

Prompt 	 If selected, the user will be prompted each time the filter is 
performed to enter desired criteria. Use this option is the  
format of the filter will remain the same, but the criteria will  
need to be different each time it’s used.  

Note: The user will only be prompted to input the criteria when using the  
Select Data icon on the main icon toolbar.  

To make the filter case sensitive, click the Case Sensitive box at the bottom 
of the filter setup window. This will return records that match the criteria in  
value and in case. If a value is entered into the criteria that does not match  
the case of the value in the record, the record will not be included in the  
filter.  

Order by tab  
Click the Order By tab to select the ordering criteria. This sorts the records 
by one or more columns in the output of the filter. The order in which 
columns appear in the ordering criteria list box determines the order of  
importance when the filter results are sorted. The first column in the  
Ordering criteria list determines the primary sort order followed by the  
second column listed etc.   

Column Type 

 Text Text Date/Time Yes/No Number 

Displayed Data Text Number Date/Time Contam/ 
OK/Retest 

Number 

Begins with Yes No No No No 

Is equal to Yes Yes Yes Yes Yes 
Is greater than Yes Yes Yes No Yes 

Is  greater than or  equal to Yes Yes Yes No Yes 
Is  less than Yes Yes Yes No Yes 

Is less than or equal   to Yes Yes Yes No Yes 
Does not  equal Yes Yes Yes No Yes 

Is empty Yes Yes Yes No Yes 
Is  not empty Yes Yes Yes No Yes 

Contains Yes No No No Yes 
Note 

 

Accepts 
only 

numberic 
values in 
criteria 

Accepts 
 only  valid 

date  values 
in  criteria. 

No time 
values 

Accepts 
 only 

 Yes, true, 
1  &  No, 

false,  zero 
in  criteria 

Accepts 
 only  

numberic  
values in  
criteria 
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Before adding a column to the ordering criteria list, select Ascending or 
Descending order options then add and remove columns as desired. An up 
or down arrow displayed next to the column name indicates if it is ascending 
or descending order. Additionally the order option can be changed from  
ascending to descending and vice versa by clicking the indicator arrow next 
to the column name.

The order of columns in the ordering criteria list can be adjusted by clicking 
on the box next to the column name and dragging to the desired location in 
the list.   

Section 7



56

Hygiena Innovate  System

Click on Show all in the symbolbar to have all data back in the database or 
if you would like to use another filter.   

If a filter is still active in the Innovate.im database and new data is received  
(indicated by a beep signal from the system), you can use the Refresh 
button to apply the active filter against the newly retrieved data.   

Go to the Menu bar of the Database and select File / Print or simply click  
on the Print icon on the symbolbar to print all filtered results of the  
database.  

You can use the Print setup function to adapt the lay-out to your 
requirements.  

Select File / Print setup. The following window will appear:   

The print setup function is divided into three different pages:  
Select Columns  / printer  

This page allows you to select the columns you wish to appear on your  
printed page. Add a column to the printed page by clicking on the column  
name in the available column list and click on Add. The column will be  
moved to the printing column list. You can remove columns from this list 
by clicking on the column name and select Remove. Column order can be  
adjusted by clicking on the box next to the column name and dragging up 
or down on the list. The printer should also be selected on this page.   
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Column layout

The column layout tab allows users to customize the printed layout of each  
column. The Width and Justification of each column can be specified.  

A Counter can be placed in front of all rows on the printout indicating each  
record number.  

The Column height in inch adjusts the height of each row in the displayed  
columns. If Stretch with overflow is checked, the column height will adjust  
automatically to display all data in the cell.  

Use Gap in inch to adjust the space between rows and columns if desired.  

Specific Font parameters and Units can also be specified.  

Use the Date column format to specify if only the Date is printed or the  
Date and Time is printed.  

Page layout   
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In the Page layout tab a custom header may be entered with specific font  
parameters. To print the filter name with the header, select Print filter  
name.

Use the Group feature to group sorted columns in the report. Select the  
column to group from the drop down menu. Column groups may be printed  
on a separate page by selecting Start each group on a new page.  

Note: Columns must be sorted using the Order by tab in the filter setup in  
order to use the Group feature.  

The current date and time can be added to the Page footer and the style 
can  be customized by selecting the desired font properties. The text box 
will  show a preview of the font properties selected. Page numbers can be 
added  by selecting Print page X of Y.  

Use the Summary section to type a custom report footer and define the font  
properties.  

Click OK to save the report layout. This layout becomes the default layout  
for each printed report and can be changed as needed.  

Export setup can be used to define specific columns for export to excel or  
another suitable program. When exporting data, a filter can be applied to  
select the desired information for export.  

Select File/Export setup. The following window will appear:   
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This page allows you to select the columns you wish to export. Add a 
column to the exporting columns by clicking on the column name in the 
selected columns list and click on Add. The column will be moved to the 
exporting columns list. You can remove columns from this list by clicking 
on the column name and select Remove. Column order can be adjusted by 
clicking on the box adjacent to the column name and dragging up or down 
on the list. When  finished click OK to save changes.

The following steps need to be taken in order to export data to excel 
or another suitable program. All results displayed on the screen will be 
exported. Apply a filter prior to exporting in order to display only the  
desired data.  

To export data click on the Export icon or select File / Export.  

The following screen will appear:   

Select directory for export. Data will be exported by clicking on Export.  
Export setup can be used to select only specific columns for export.  

You should create a backup of the database tables on a regular basis. If the  
database is lost or damaged, you won’t be able to start it until you restore it.  

Create a backup for the database tables in the selected directory. Copy all 
files in this directory or another backup medium of your choice.  

Contact your Hygiena Technical representative in case you have further  
questions.  

To ensure optimal performance, you should compact the database on a 
regular basis.  

If a serious problem occurs while you are working with the database, you  
should compact the database.  
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If a serious problem occurs while you are working with the database, you  
should first compact the database before you restore the database  

If the compact operation didn’t solve your problem, use restore to restore 
your database tables to a previous state.  

When performing database restore, select the backup folder created in the  
appropriate location.  
 

To improve performance of the database, you can archive old data. Routine  
database tables should not exceed 30,000 records. Once 30,000 records 
is reached, please archive routine database tables. To view archived data, 
switch rom Routine view to Archive view using the select view box in the 
toolbar.  
Data should first be exported to excel before archiving.  

Contact your Hygiena Technical representative in case you have further  
questions.  

If the filtering process in Archive view becomes too slow, a new archive 
table can be created. This will improve filtering performance when running 
queries in the archive. Archive database tables should not exceed 120,000 
records.  

To create a new archive table  

1.  Login to Innovate.im as System Manager or Celsis and open the  
Database.  

2.  Select File>Create New Archive  

3.  In the dialogue box that appears name the archive table currently in use.  

4.  Click Create. The current archive in use is renamed as specified and 
a new empty archive table is created named “Archive.” When Archive  
Transfer is performed, the data will be archived to the new archive table.   
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To rename an old archive table  

1.	 Login to Innovate.im as System Manager or Celsis and open the  
Database.  

2.	 Select File>Create New Archive  

3.	 In the New archive name section of the dialogue box select the desired  
new name of the archive. The desired new name must not already exist.  

4.	 Then select the desired archive to be renamed below.  

5.	 Click Rename. The old archive is renamed. If the name chosen is already 
in use, the operation is cancelled.  

To delete an archive table  

1.	 Login to Innovate.im as System Manager or Celsis and open the  
Database.  

2.	 Select File>Create New Archive.  

3.	 From the Select an archive that you want to rename or delete drop down  
box, select the archive for deletion and click Delete.  

The database tables can be stored on a local network to allow multiple user  
accessibility. To set up database tables on a local network, see instructions 
in section 3.3 above.  

To access network settings for the database software, open the database 
and select Options from the top menu bar. Click on Network Settings. This 
feature is only visible when logged into Innovate.im as System Manager or 
Celsis and allows the user to move the database tables to a folder on the 
local network drive using the Move Tables tab. Other workstations can then 
be linked to this table by selecting the Link Tables tab and referencing the 
appropriate location of the network database table. Network database table 
report and filter settings can be shared. Data upload settings can also be 
customized.  

It is best to designate one workstation on the network as the master 
workstation. Other workstations on the network can be linked so that they 
utilize the report and filter settings of the master workstation. This allows 
centralized control of these features.   
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Reports can be set up and shared via a local network so that all 
workstations have access to the same report format.

To set up shared report settings  

1.	 Create an InnovateIM Database Report Settings folder on the local  
network drive. All workstations must have full permissions to this folder.  

2.	 Open the Database software and select Options from the top menu.  

3.	 Open the Network Settings option.  

4.	 Click on the Report/Filter tab and click the ellipsis (…) box next to  
Directory for the report settings box.  

5.	 Navigate to the InnovateIM Database Report Settings folder on the  
network and select this folder to link to the current workstation. The  
print settings for the current workstation will now be the same for all  
subsequent workstations linked to this folder. When changes are made 
to the  report settings on this workstation, all workstations linked to the  
network report settings folder will also be changed.  

To link a workstation to the Database Report Settings folder  

1.	 Login to the workstation as System Manager or Celsis.  

2.	 Open the Database software and select Options>Network Settings.  

3.	 Click on the Report/Filter tab and using the ellipsis (…) box next to the  
Directory for the report settings box navigate to the appropriate folder  
on the network where the database report settings are stored and select  
this folder. This workstation will now use the print settings located in  this 
folder.  

4.	 To revert back to print settings on the local drive of the workstation,  
change this option to the InnovateIM folder on the local drive.  

Queries can be set up and shared via a local network so that all 
workstations have access to the same queries.  

To set up shared queries.  

1.	 Create an InnovateIM Database Filter Settings folder on the local  
network drive. All workstations must have full permissions to this folder.  

2.	 Open the Database software and select Options from the top menu.  

3.	 Open the Network Settings option.  

4.	 Click on the Report/Filter tab and click the ellipsis (…) box next to  
Directory for the filter settings box.   
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5.	 Navigate to the InnovateIM Database Filter Settings folder on the  
network and select this folder to link to the current workstation. 
The queries for the current workstation will now be the same for all  
subsequent workstations linked to this folder. When changes are made 
to the report settings on this workstation, all workstations linked to the  
network report settings folder will also be changed.  

To link a workstation to the Database Filter Settings folder,  

1.	 Login to the workstation as System Manager or Celsis.  

2.	 Open the Database software and select Options>Network Settings.  

3.	 Click on the Report/Filter tab and using the ellipsis (…) box next to the  
Directory for the filter settings box navigate to the appropriate folder on  
the network where the database filter settings are stored and select this  
folder. This workstation will now use the queries located in this folder.  

4.	 To revert back to filter settings on the local drive of the workstation, 
change this option to the InnovateIM folder on the local drive.   
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